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Panoramica su Draw

Panoramica su Draw

Draw è un programma di disegno vettoriale. Tramite i potenti strumenti di cui è dotato, potete 
realizzare rapidamente ogni tipo di disegno. La grafica vettoriale memorizza e visualizza le 
immagini utilizzando vettori (linee comprese tra due punti) invece di un insieme di pixel (punti 
sullo schermo). Le immagini generate con grafica vettoriale occupano un minor spazio su 
disco e possono essere facilmente scalate.

Draw è perfettamente integrato in OpenOffice.org e ciò agevola notevolmente lo scambio di 
disegni con tutti gli altri componenti della suite. Per esempio, per riutilizzare un'immagine 
creata in Draw in un documento Writer è sufficiente eseguire un copia e incolla. Potete inoltre 
disegnare direttamente in Writer e Impress, usando alcune delle funzioni e degli strumenti di 
Draw.

Draw offre un insieme di funzioni ampio e completo. Anche se non è stato progettato per 
rivaleggiare con applicazioni grafiche più sofisticate, Draw possiede una quantità di funzioni 
superiore a molti programmi di disegno integrati in altre suite per la produttività d'ufficio.

Alcuni esempi delle funzioni da disegno possono suscitare la vostra curiosità: gestione dei 
livelli, griglia magnetica, visualizzazione di dimensioni e misure, possibilità di creare 
organigrammi, funzioni 3D per creare piccoli disegni tridimensionali (con trame ed effetti di 
luce), integrazione di disegni e modelli di pagina, e le curve di Bézier, solo per nominarne 
alcune.
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L'area di lavoro

L'area di lavoro

I principali componenti dell'interfaccia di Draw sono mostrati nella Figura 1.

Figura 1 - Finestra iniziale di Draw.

La grande area al centro dello schermo è quella in cui si realizzano i disegni. Quest'area è 
circondata da barre degli strumenti e aree di informazioni. È possibile variare il numero e la 
posizione degli strumenti visibili, per cui la vostra configurazione potrebbe essere differente. 
Per esempio, molti posizionano la barra Disegno sul lato sinistro dell'area di lavoro e non nella 
parte inferiore come mostrato nella figura.
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Le barre degli strumenti

Le barre degli strumenti

Le diverse barre degli strumenti di Draw possono essere mostrate o nascoste in base alle vostre 
necessità.

Molte delle barre mobili presenti in OOo 1.x sono diventate barre principali in OOo 
2.0.

Per visualizzare o nascondere le barre degli strumenti, fate clic semplicemente su Visualizza > 
Barre dei simboli. Nel menu che appare, selezionate le barre da visualizzare.

Potete inoltre selezionare i pulsanti che si vogliono mostrare nella corrispondente barra degli 
strumenti. Dal menu Visualizza > Barre dei simboli, selezionate Personalizza, fate clic sulla 
scheda Barre dei simboli (vedere la Figura 2), e quindi selezionate i pulsanti per la specifica 
barra. Ogni barra degli strumenti presenta un differente elenco di pulsanti.

Figura 2 - Personalizzare una barra degli strumenti.

Introduzione a Draw 3



Le barre degli strumenti

In molti pulsanti delle barre degli strumenti troviamo una piccola freccia posta a lato del 
pulsante. La freccia indica che il pulsante dispone di funzioni aggiuntive. Fate clic sulla freccia 
per far apparire un sottomenu o una barra mobile che mostra le funzioni aggiuntive (vedere la 
Figura 3).

Figura 3 - Una freccia a lato del 
pulsante indica funzioni aggiuntive.

Allo stesso modo, fate clic sulla freccia nella barra del titolo di una barra mobile per 
visualizzare le funzioni aggiuntive (vedere la Figura 4).

Figura 4 - Una freccia in una barra mobile indica funzioni aggiuntive.

È possibile mantenere visibile il sottomenu sullo schermo, ma in una posizione diversa da 
quella predefinita. Potete trasformare questo sottomenu in una barra mobile. Per fare ciò, fate 
clic sulla barra del titolo del sottomenu, trascinatela nel punto desiderato dello schermo e 
quindi rilasciate il pulsante del mouse.

Nota: La maggior parte dei pulsanti contrassegnati da una piccola freccia a lato possono 
diventare barre mobili. Le barre mobili sono una caratteristica presente in tutti i 
componenti della suite OpenOffice.org.

Nelle sezioni seguenti sono spiegati gli strumenti disponibili nelle varie barre degli strumenti.
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Le barre degli strumenti

La barra Standard
La barra Standard presenta l'aspetto seguente:

È la stessa per tutti i moduli di OpenOffice.org.

La barra Stile e riempimento
La Barra Linea e Riempimento (definita Barra oggetti in OOo 1.x) permette di modificare le 
principali proprietà dell'oggetto che si sta disegnando.

Nell'esempio precedente, le funzioni disponibili permettono di modificare il colore di una linea 
disegnata, il colore di riempimento e altre proprietà dell'oggetto selezionato. Se l'oggetto 
selezionato è un testo, la barra cambia come riportato nella figura seguente, che assomiglia alla 
barra Formattazione presente in Writer.

La barra Disegno
La Barra Disegno è la barra più importante in Draw. Essa contiene tutte le funzioni necessarie 
per disegnare diverse forme geometriche e libere e per poterle organizzare nella pagina.

Disegnare una linea retta

Di seguito sono elencati i passaggi per disegnare una linea retta. Fate clic sul bottone Linea 

nella barra Disegno  e posizionate il cursore del mouse nel punto in cui volete iniziare il 
disegno.

Trascinate il mouse tenendo premuto il pulsante. Rilasciate il pulsante del mouse quando 
volete interrompere la linea. Su ciascuna estremità della linea apparirà una maniglia blu o 
verde, indicando che l'oggetto è selezionato. Il colore dipende dal modo di selezione standard 
impostato (sarà verde per la selezione semplice mentre sarà blu per la modalità modifica).
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Le barre degli strumenti

Figura 5 - Disegnare una linea retta.

Per disegnare una linea con un angolo multiplo di 45° rispetto all'asse orizzontale, tenete 
premuto il tasto (Maiusc) mentre si traccia il segmento

Tenete premuto il tasto Control (Ctrl nei PC), per limitare la rotazione ad angoli di 15°. Potete 
definire tale angolo in Strumenti > Opzioni > OpenOffice.org Draw > Griglia.

Tenete premuto il tasto (Alt) per tracciare la linea simmetrica dal punto di partenza (la linea si 
estende da entrambe le parti del punto di partenza in maniera uguale). In questo modo è 
possibile tracciare delle linee rette partendo dal punto di mezzo della linea.

La linea che tracciate avrà gli attributi predefiniti (come il colore e il tipo di linea). Per 
modificare gli attributi della linea, fate clic sulla linea per selezionarla quindi usate gli 
strumenti presenti nella Barra linea e riempimento. In alternativa fate clic con il pulsante 
destro sulla linea e scegliete Linea per aprire la finestra di dialogo Linea.

Disegnare un rettangolo

Disegnare rettangoli è simile a tracciare linee rette, ad eccezione che si usa il pulsante 
Rettangolo   della barra Disegno. La linea (immaginaria) tracciata con il mouse 
corrisponde alla diagonale del rettangolo.

Figura 6 - Disegnare un rettangolo.

Tenete premuto il tasto (Maiusc) per disegnare un quadrato. Tenete premuto il tasto (Alt) per 
disegnare un rettangolo partendo dal centro.
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Le barre degli strumenti

Disegnare una circonferenza

Per disegnare un'ellisse o una circonferenza utilizzate il pulsante Ellissi  della barra 
Disegno (infatti una circonferenza è un'ellisse in cui i due assi hanno la stessa lunghezza). 
L'ellisse disegnata sarà inscritta nel rettangolo immaginario tracciato con il mouse.

Figura 7 - Disegnare una circonferenza.

Nella barra degli strumenti Disegno sono disponibili altre forme.  Nelle precedenti 
versioni di OOo, queste forme erano funzioni estese che apparivano facendo un clic 
prolungato sul pulsante Ellisse.

Ci sono altri tre modi per disegnare una ellisse o una circonferenza:

• Tenete premuto il tasto (Maiusc) per forzare il disegno di una circonferenza.

• Tenete premuto il tasto (Alt) per disegnare un'ellisse simmetrica o una circonferenza 
partendo dal centro invece che da uno degli angoli.

• Tenete premuto il tasto (Ctrl) mentre si disegna per agganciare l'ellisse o la 
circonferenza alle linee della griglia.

Nota: Tenendo premuto il tasto (Ctrl) mentre fate clic su uno di questi bottoni (Linea, 
Rettangolo, Ellisse e Testo), l'oggetto scelto apparirà direttamente nella pagina con 
dimensioni, forma e colore predefiniti. Potrete successivamente modificare gli oggetti 
secondo le vostre necessità.

Scrivere testo

Utilizzate lo strumento Testo per scrivere un testo e selezionare il carattere, il colore, le 
dimensioni e altri attributi. Fate clic su uno spazio vuoto dell'area di lavoro per scrivere il testo 
partendo da quel punto. Se fate clic su di un oggetto, il testo verrà scritto al centro dell'oggetto 
stesso e rimarrà a esso legato.  Il margine dell'oggetto diventa la cornice del testo.

Quando avete terminato di digitare il testo, fate clic all'interno della cornice del testo. Premete 
(Invio) per passare alla riga successiva. Fate doppio clic sul testo in qualsiasi momento per 
modificarlo.
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Le barre degli strumenti

Quando si digita un testo, la barra superiore include gli attributi classici del paragrafo: 
rientranze, prima linea e tabulazioni.

Potete cambiare lo stile di tutto o di una parte del testo. Anche in questo contesto potete 
utilizzare la finestra di dialogo Stilista (selezionare Formato > Stilista oppure premere F11 
per attivarla), tramite la quale potete creare stili da riutilizzare in altre strutture di testo, 
esattamente come in Writer.

Le cornici di testo possono anche avere colori di riempimento, ombre e altri attributi, proprio 
come ogni altro oggetto di Draw. Potete ruotare il riquadro e scrivere il testo con qualsiasi 
angolazione. Queste opzioni sono disponibili facendo clic destro sull'oggetto.

Usate lo strumento Legende, nella barra Disegno, per creare didascalie (denominate anche 
etichette)

La barra Colore
Per visualizzare la Barra dei colori, utilizzate Visualizza > Barre dei simboli > Barra dei 
colori. La barra appare alla base dell'area da lavoro.

Questa barra vi permette di scegliere rapidamente il colore degli oggetti presenti nel disegno. Il 
primo quadrato nel pannello corrisponde alla trasparenza (assenza di colore).

Il pannello dei colori standard può essere modificato usando Formato > Area come mostrato 
nella Figura 8 Scegliete la scheda Colori.

Figura 8 - Modificare la tavola dei colori
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Le barre degli strumenti

Se fate clic sul pulsante Carica tavola dei colori (cerchiato), la finestra di dialogo vi chiede di 
scegliere un file tavola colori (con estensione .soc). OpenOffice.org è fornito con diverse 
tavole dei colori predefinite. Per esempio, web.soc è una tavolozza dei colori particolarmente 
indicata per  disegni destinati a essere utilizzati in pagine Web, perché i colori saranno mostrati 
correttamente su macchine in grado di visualizzare almeno 256 colori.

La scheda Colori vi permette anche di cambiare individualmente qualsiasi colore modificando 
il valore numerico nei campi localizzati alla destra della tavola dei colori. Potete inoltre fare 
clic su Modifica per visualizzare una finestra di dialogo (mostrata nella Figura 9),rendendo la 
scelta dei colori più facile.

Figura 9 - Definire gli schemi dei colori

Potete usare gli schemi dei colori conosciuti come CMYK (Ciano, Magenta, Giallo, Nero), 
RGB (Rosso, Verde, Blu) o HSB (Colore, Saturazione, Luminosità).

La barra Opzioni
Questa barra vi permette di attivare o disattivare varie opzioni di aiuto al disegno. La barra 
Opzioni non è di norma visualizzata. Per mostrarla, selezionate Visualizza > Barre dei 
simboli > Opzioni.
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Le barre degli strumenti

Gli strumenti di cattura (ancoraggio) sono divisi in 3 gruppi: la griglia magnetica, le linee di 
cattura e i punti di cattura. Ancorare alla griglia, alle linee o ai punti richiede tre passaggi:

1) Mostrate la griglia, le guide o i punti.

2) Fate clic sul pulsante opportuno.

3) Trascinate l'oggetto vicino al punto di cattura.

Usare la griglia

Draw fornisce una griglia di punti a cui potete ancorare gli oggetti. Fate clic sul pulsante 
Mostra griglia nella barra Opzioni per visualizzare la griglia, quindi fate clic sul pulsante 
Cattura alla griglia per attivarla. L'area di lavoro verrà riempita da una griglia, come mostrato 
nella Figura 10. Questa griglia non verrà stampata né apparirà nei file esportati, come ad 
esempio in PDF.

Quando la griglia è attiva, potete posizionare facilmente le forme usando i punti come guida. 
Nell'esempio seguente, le maniglie dell'oggetto sono posizionate esattamente sui punti della 
griglia.

La spaziatura fra i punti viene definita nella finestra di dialogo Griglia che a sua volta si trova 
nell'area Disegno fra le opzioni di OOo.(Strumenti > Opzioni > OpenOffice.org Draw > 
Griglia).
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Le barre degli strumenti

Figura 10 - Esempio di griglia

Con la finestra di dialogo mostrata nella Figura 11, potete impostare i seguenti parametri:

• Spaziatura verticale e orizzontale dei punti nella griglia. Potete anche cambiare l'unità 
di misura usata.

• La risoluzione è la dimensione dei quadrati o dei rettangoli nella griglia.  Se la 
risoluzione è di 1 cm orizzontale e 2 cm verticale, la griglia è costituita da rettangoli di 
2 cm di altezza e 1 cm di larghezza.

• Le suddivisioni sono ulteriori punti che appaiono lungo i lati di ciascun rettangolo o 
quadrato nella griglia. Gli oggetti si ancorano alle suddivisioni come agli angoli della 
griglia.

• La dimensione in pixel dell'area di cattura definisce quanto vicino dovete portare un 
oggetto al punto o linea di cattura perché questo venga catturato.

Figura 11 - Impostare le opzioni della griglia
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Le barre degli strumenti

I righelli
I righelli sono posizionati sul lato superiore e sinistro dell'area di lavoro (figura 12). I righelli 
indicano le dimensioni degli oggetti presenti nella pagina. Mostrano inoltre la posizione del 
mouse per consentirvi di collocare gli oggetti in modo più preciso. I righelli inoltre sono usati 
per gestire i punti maniglia e le linee di cattura che rendono più facile il posizionamento degli 
oggetti.

I margini della pagina nell'area da disegno sono anch'essi rappresentati sui righelli. Potete 
modificare i margini direttamente sui righelli trascinandoli con il mouse. Per modificare le 
unità di misura dei righelli, fate clic destro su uno dei due righelli. I due righelli possono 
utilizzare differenti unità di misura.

Figura 12 - I righelli in un disegno

La barra di stato

La Barra di stato è localizzata nella parte inferiore dello schermo. La parte centrale di 
quest'area è particolarmente importante per il modulo Draw.

I valori sono espressi nell'unità di misura corrente (da non confondere con le unità dei righelli). 
Questa unità è definita in Strumenti > Opzioni > OpenOffice.org Draw > Generale, dove 
inoltre è possibile cambiare la proporzione della pagina. Un altro modo per cambiare la 
proporzione è fare doppio clic sul numero mostrato nella Barra di stato.

Funzioni avanzate

Draw contiene diverse funzione avanzate che sono utili in certi casi specifici (immagini web e 
scambio dati).
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Funzioni avanzate

Duplicazione
Questa funzione duplica una forma e permette di modificare le opzioni applicate ai duplicati.

Per avviare la duplicazione, fate clic su un oggetto (o su un gruppo di oggetti selezionati), 
quindi scegliete Modifica > Duplica.

Appare la seguente finestra di dialogo.

Potete scegliere:

• Il numero di copie.

• Lo spostamento lungo gli assi X e Y tra le due copie.

• L'angolo di rotazione tra le due copie.

• Le variazioni di dimensioni tra ciascuna copia.

• I colori della copia iniziale e di quella finale..

Le opzioni precedenti applicate ad un rettangolo blu producono il seguente risultato:

Introduzione a Draw 13



Funzioni avanzate

Il risultato finale di una duplicazione è un nuovo gruppo.

Morphing
Il morphing trasforma una forma in un'altra. OpenOffice.org si occupa di tutte le transizioni 
intermedie. Il risultato è un nuovo gruppo di oggetti.

Per realizzare un morphing, selezionate entrambi gli oggetti (tenete premuto il tasto (Maiusc) 
mentre si seleziona ogni oggetto) quindi scegliete Modifica > Morphing. Appare la seguente 
finestra di dialogo:

Di seguito è riportato un esempio di utilizzo.

Partiamo da  due forme...

 ...ed eseguiamo un morphing per ottenere il seguente disegno:
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Funzioni avanzate

Scambiare oggetti con altri programmi
Per salvare un'immagine Draw in un altro formato, usate File > Esporta. Draw può salvare in 
diversi formati file grafici, elencati nel capitolo 3 “Gestione file” all'interno di questa guida.

Potete inoltre esportare i file Draw nei formati HTML, PDF, e Flash. L'esportazione nel 
formato PDF è la stessa attuata negli altri componenti di OpenOffice.org, come descritto nel 
capitolo 3 “Gestione file” di questa Guida. L'esportazione nel formato Flash crea un file .swf.

L'esportazione nel formato HTML usa una procedura guidata di conversione che crea tante 
pagine web quante sono le pagine presenti nel documento Draw. Come opzione potete 
scegliere di visualizzare le pagine in cornici con un navigatore e impostare una pagina di 
indice.1 Per maggiori informazioni fate riferimento al capitolo 16, “Creare pagine web: salvare 
i documenti come file HTML” in questa guida.

1 Questa procedura guidata è la stessa presente in OpenOffice.org Impress.
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